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Notation 
The following topics, which are necessary when using this product, are 
described below. 

 

MEMO 
Additional information regarding operation, descriptions, and settings is 
provided. 
 

MMMEEEMMMOOO   
♦  

 

IMPORTANT 
This gives the user important information regarding handling, that is 
required for ensuring safety. 
Important information regarding operation, descriptions, and settings is 
provided. 
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♦  
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Chapter 1 Overview and Basic Operations 
of Run 

This chapter describes an overview and basic operation procedures of Run, 
a program that executes the screen data created in Builder. 
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 Chapter 1 Overview and Basic Operations of Run 

1-1 MP2500 Copy of Project 
Data and Start-up 

Run 

 

1-1 MP2500 Copy of Project Data and Start-up 
Explains how to copy data, which is made in the Builder program, to the 
MP2500 register and how to start the MotionScreen Run. 
 

Copying Project Data 
1. Copy the .ini files, INTACORE.INI and CM.INI, in the project folder 

and move them to the folder in which MotionScreen is installed. 
2. Copy the project file and project folder and move them to the Data 

folder under the folder in which MotionScreen is installed. 
3. Copy the file in the “DataFile” folder and move it to the folder which 

was set in the New Project wizard for Builder or set as the “Read 
file/Save file location” in the project properties. 

 

MEMO 
♦ If a folder has not been set as the “Read file/Save file location,” the file in 

the “DataFile” folder do not have to be copied. 
Refer to the MotionScreen Builder manual if making any settings with the 
New Project wizard or in the Project Properties box. 

MMEEMMOO 
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Example: 
The following example shows how the Sample file of project data that was 
made with Builder is stored and how E:\Work is selected as the “Read 
file/Save file location.” 
 
   Project data made with Builder 

 

C:\Program Files\MotionScreen\MyProj \Sample.IPP 
                                  \Sample\PNLPG000.IPW  
                                  \PNLPG001.IPW  
                                  \    … 

                     \INTACORE.INI 
                     \CM.INI 

             
             

Copy and move 
to the Data folder. 

Copy and move to an 
installation folder. 

                                  \DataFile\….CSV 
                                   \….BMP 
                                   \….TXT 
                                   \….LST 
                                   \ … 

 
   Destination for the MP2500- 
   register copy 

 

C:\Program Files\MotionScreen \INTACORE.INI  
 \CM.INI  
 \DATA\Sample.IPP 
                                 \Sample\PNLPG000.IPW 
                                 \PNLPG001.IPW 
                                 \   … 
E:\Work \….CSV 

 \….BMP 
 \….TXT 
 \….LST  
 \ … 
 

Copy and move to the  
Read file/Save file location. 
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Starting a Project 
Run the program file, C: \Program Files\MotionScreen\INTACORE.EXE. 
MotionScreen Run starts, and the copied project opens. 
 

MEMO MMEEMMOO  
♦ Make sure to copy the .ini files, INTACORE.INI and CM.INI, otherwise 

another project may open and communications with the MP2500 will not be 
possible. 
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1-2 Main Screen 
This section describes the configuration of the Run operation screen and 
the names and functions of each section.  
 

 Title bar  

Display screen 

 
 
 
 

Menu bar 

 
 
 
 
 
 

 
Title bar 
Displays the application name, project name, and the title of the displayed 
screen. 

 

Menu bar 
Groups each function with related functions. 
The name of each group is displayed in the menu bar, and the functions 
within each group are displayed in the pull down menu. 
Menus have the following configuration. 
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File 
 

Item Function 
Open project Selects a project. 
Select page Selects the screens to display. 
Quit Exits the application. 

 
Display 
 

Item Function 
Title Selects the show/hide settings of the title bar. 
Menu Selects the show/hide settings of the menu bar. 
Full screen Switches the display to full screen. 

 
Option 
 

Item Function 
Input mode Selects the input mode (keypad/external device (keyboard, 

etc.)) of [Numeral Display&Input] and [String 
Display&Input]. 

Caption mode Selects the label display/address display. 
About product Information Displays the product information. 
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1-3 Startup Setting 
Before starting Run, you must first configure the start settings or the 
startup conditions in the preferences file. 
By configuring the start settings, you can automatically start Run or other 
applications such as CM during the system startup. 
 

Settings 
The startup settings are configured in the INTACORE.INI file, which is 
located in the same folder as the INTACORE.EXE file. 
The contents and setting procedure for INTACORE.INI are shown below.  
 
# ----------------------------------------------------------------------------  
# Startup and Shutdown  
# ----------------------------------------------------------------------------  
# 0or1 
ACTMENU=1 
SHUTDOWNDLG=2 
# ----------------------------------------------------------------------------  
# Shared memory  
# ----------------------------------------------------------------------------  
# 0 <= n <= 64 K bit 
#CBNUM=4 
# 0 <= n <= 8192 K word 
#CWNUM=4 
# 0 <= n <= 32 
TASKNUM=32 
# 0 <= n <= 999999 
WAITTIME=0 
# 0 or 1 
#MEMHOLD 
# file name 
#HOLDFILE= 
# ----------------------------------------------------------------------------  
# APP1  
# ----------------------------------------------------------------------------  
# 0or1 
APP01=1 
# maxlen 128 
APP01NAME=CM.exe 
# maxlen 128 
APP01CRNTDIR=.\ 
# maxlen 128 
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APP01COMMAND= 
# maxlen 256 
APP01TITLE=CM 
# 0 <= n <= 999999 
STARTAPP01WAIT=100 
# ----------------------------------------------------------------------------  
# APP2  
# ----------------------------------------------------------------------------  
# 0or1 
APP02=1 
# maxlen 128 
APP02NAME=SetVer.exe 
# maxlen 128 
APP02CRNTDIR=.\ 
# maxlen 128 
APP02COMMAND=.\Version.ini 
# maxlen 256 
APP02TITLE= 
# 0 <= n <= 999999 
STARTAPP02WAIT= 
# ----------------------------------------------------------------------------  
# APP3 
# ----------------------------------------------------------------------------  
# 0or1 
APP03=1 
# maxlen 128 
APP03NAME=Pn.exe 
# maxlen 128 
APP03CRNTDIR=.\ 
# maxlen 128 
APP03COMMAND=/p.\Data\Sample.IPP 
# maxlen 256 
APP03TITLE= 
# 0 <= n <= 999999 
STARTAPP03WAIT= 
       ･       ･       ･ 
 
# 
CBNUM=4 
# 
CWNUM=4 
# 
SBNUM=2 
# 
SWNUM=2 
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Startup and Shutdown 
Environment 

variables Setting range Contents Target 

ACTMENU 0: Disables all environment 
variables 

1: Enables all environment 
variables 

Enables/Disables the  
settings of the 
INTACORE.INI file. 

MotionScreen 

SHUTDOWNDLG Selects the exit operation 
of MotionScreen and 
Windows. 
The operations of setting 
0 and 1 are valid when 
the OS is set to turn off 
the power when exiting.
If the power-off operation 
is not set, settings 0 and 
1 are equivalent to 
settings 2 and 3 
respectively. 
 
This setting will be 
effective when $SB255 is 
ON. 

 
 

0: Displays the message “Shut 
down the system?” Exits 
MotionScreen and turns off 
the computer. 

1: Exits MotionScreen and 
turns off the computer 
without displaying the 
message “Shut down the 
system?”  

2: Displays the message “Shut 
down the system?” Exits 
MotionScreen, but does not 
turn off the computer. 

3: Exits MotionScreen without 
displaying the message “Shut 
down the system?” but does 
not turn off the computer. 
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Shared memory 
Environment 

variables Setting range Contents Target 

CBNUM 1 to 64 (Default: 32, set to default 
when 0) 

Sets the number of CB 
points to use (K=1024). 

INTACORE.EXE 

CWNUM 1 to 8192 (Default: 64, set to 
default when 0) 

Sets the number of CW 
points to use (K=1024). 

 

 SBNUB 2 These values are system 
reservations and should 
not be changed.   

SWNUB 2 These values are system 
reservations and should 
not be changed.   

 

TASKNUM 1 to 32 (Default: 16, set to 
default when 0) 

Sets the maximum 
number of connect tasks.

 

WAITTIME 0 to 999999 Sets the waiting time 
(ms) after the application 
startup. 

 

MEMHOLD − These values are system 
reservations and should 
not be changed.   

 

HOLDFILE − These values are system 
reservations and should 
not be changed.   
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APP01 to APP08 
Environment 

variables Setting range Contents Target 

APP01 to APP08 0: Does not start. 
1: Starts. 

Enables/Disables the 
startup settings of the 
applications for APP1 to 
APP8. 

Application 

APP01NAME to 
APP08NAME 

Up to 128 characters of string. Specifies the execution 
file name. 

 

APP01CRNTDIR 
to 
APP08CRNTDIR

Up to 128 characters of string. Specifies the path of the 
execution file. 
If the path includes 
spaces, specify the entire 
path in double 
quotations. 

 

Specifies the startup 
argument (command). 
If the path includes 
spaces, specify the entire 
path in double 
quotations. 

 APP01COMMAND 
to 
APP08COMMAND

Up to 128 characters of string. 

APP01TITLE to 
APP08TITLE 

Up to 128 characters of string. Specifies the screen title.
This is invalid if 
overwritten by the 
application. 

 

STARTAPP01WAIT 
to 
STARTAPP08WAIT

0 to 999999 Sets the wait time for 
the next application to 
execute after the 
application startup. 

 

 

MEMO MMEEMMOO  
♦ Do not change the settings of APP01to APP03 because they are automatically 

set in accordance with information related to the project. 
Use APP04 to APP08 if adding an application which will start at the same 
time as the Run program.   

♦ When Run is started, INTACORE.EXE is automatically started at the same 
time. If APPxx (xx = 01 to 08) is used to set the startup of Run (PN.EXE), two 
instances of Run will start up: Run started manually and Run started by 
INTACORE.INI. Because of this, if Run is started by INTACORE.INI, make 
sure to start INTACORE.EXE.  

♦ Rows starting with “#” in INTACORE.INI are treated as comments.  
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1-4 Basic Operations 
This section describes the basic operations of Run. 
 

Opening a project 
This section describes how to select a project to execute in Run. 
You can also specify a project file to execute during startup in the 
INTACORE.INI file, which was described in the previous section. 

 

1. Select [Open project] from the [File] menu. 
 

2. A dialog box for opening a project is displayed. 
 

 
 

3. Select a project, then click the [Open] button. 
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Switch screen 
This section describes how to jump to another screen in Run. 

 

1. Select [Select page] from the [File] menu. 
 
2. A dialog box for selecting a screen page is displayed. 
 

 
3. Select a screen page, then click the [OK] button. 
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Screen display 
When a project is executed, a screen is displayed according to the screen 
style specified in the [Run parameter setting] ([Settings] – [Run 
parameter setting] – [Initial Setting]) of Builder. 
To change the screen style when running in Run, double click anywhere in 
the screen where there is no functional object. 
The screen style changes in the following order. 
Full Screen → Window (with menu bar, title bar) → Window (with menu 
bar) → Window (with title bar) → Window (without menu bar, title bar) → 
Full Screen (back to the beginning of the cycle) 

 

 

 

(Without menu bar, title bar) 

Full Screen 

Window 

Window 

Window  
(With menu bar, title bar) 

 

 

Window 
(With menu bar) 

(With title bar) 
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MEMO MMEEMMOO  
♦ If Change Window Style has not been selected in the Option settings of the 

Run parameter settings in Builder, the style of the windows cannot be 
changed while the Run program is being executed. 
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Option functions 
This section describes an overview of the option functions. 

 

Input mode 
This switches the input mode of the Numeral Display&Input and String 
Display&Input functional objects from the input of the input pad, which is 
displayed when clicking the object, to the input mode of external devices 
such as the keyboard. 

 

1. Select the [Input mode] from the [Options] menu. 
 

 
 
 
 
 
 
 
 
 
 
 
 

MEMO 
♦ To switch the input mode, select [Input mode] from the [Options] menu 

again. 

MMEEMMOO  

♦ The initial settings of the input mode are set in the [Options] of the [Run 
parameter setting]. 

 

Input Mode 
– Input from the input pad 

The input pad is not displayed. 

Input Mode 
– Input from an external device 
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Displaying label addresses 
The display mode can be switched from the standard label display to the 
display of the address specified for each functional object. 
The only address displayed with this function is the information set in the 
[General] tab of each functional object’s property dialog box. For details on 
the address display, refer to “Displaying addresses” in “Changing object 
display items“ in “4-1 Common Operations” of the Builder manual. 
 Label Display Address Display 
 
 

 
 
 
 

 
1. Select [Caption mode] from the [Options] menu. 

 

MEMO 
♦ 
MMEEMMOO  

The mark before the [Caption mode] menu indicates that the address is 
displayed in the current screen. 

♦ To switch the label device display, select [Caption mode] from the [Options] 
menu again. 

 

Product information 
Displays the name, version, and copyright of the application. 
  
 
 
 
1. Select [About product Information] from the [Options] menu.                  

Application name and version 

Copyright information 

2. Click the [OK] button to close it. 
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Input pad 
This section describes how to use the input pad used when inputting 
numbers or string. 
 
Numeral keypad 
This is used when inputting numeral data to the Numeral Display&Input 
object. The numeral keypad is displayed when pressing the Numeral 
Display&Input object. 
 

 
 
 

1) 
2) 
3) 

1)
2)

3)4) 

5) 

6) 

 
 
 

4)

5)

6)
 
 
 

Number Item Contents 
1) MAX Displays the upper limit of the input. 
2) MIN Displays the lower limit of the input. 
3) [BS] button Erases the last character of the entered values. 
4) [CLR] button Clears the current values. 
5) [CANCEL] 

button 
Disregards the entered values and exits the keypad. 

6) [ENTER] 
button 

Sets the entered values and exits the keypad. 
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Virtual keyboard 
This is used for inputting string data to the String Display and Input 
object or for entering passwords when inputting to functional objects. 
The virtual keyboard is displayed when the String Display and Input 
object is pressed. When entering passwords, this is displayed by pressing 
the [Keyboard] button in the [PASSWORD] dialog box. 
Available keyboards vary according to the display format. A full-size 
keyboard is used for entering passwords. 

 

[Keyboard Types] 
 

Full keyboard Decimal keys  
(unsigned) 

Hexadecimal keys 
(unsigned) 

  
Decimal keys  Decimal keys 

(signed, ∗, and /) (signed) 
Hexadecimal keys 

(signed) 

   
Hexadecimal keys 
(signed, ∗, and /)   
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[Virtual Keyboard Operations] 
 

 

1)

 
 
 
 

2)
3)
4)
5)

8)7) 

6)

 
 
 

The operations are basically the same as an ordinary keyboard. For 
operations on keyboards other than full-size keyboards, refer to the 
previous section, “Numeral keypad”. 

 

1) Closes the virtual keyboard when this button is pushed. 
 

2) Nullifies the entered string and exits the virtual keyboard. 
 

3) Erases the last character of the string. 
 

4) Clears all string. 
 

5) Enters a space each time it is pressed. 
 

6) Sets the entered string and exits the virtual keyboard. 
 

7) Turns on the [Caps Lock]. 
 

8) Changes the display of the selected characters to symbols such as !, $, 
#, or %. This does not effect the uppercase or lowercase letters of 
alphabets. 
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Entering passwords 
Pressing a functional object with password settings displays a dialog box 
that requests the input of a password. 
 

 
 

1. Enter the password. The entered password is displayed in asterisks 
(“∗”). 

 
2. Click the [OK] button. 
 
3. If the password is correct, the functional object is valid for input. 

 

MEMO MMEEMMOO  
♦ If an invalid password is entered three times, the [PASSWORD] dialog box 

closes. To enter the password again, press the functional object and display 
the [PASSWORD] dialog box. 
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Setting the date and time 
This section describes how to set the date and time. Press the date or time 
functional object to display the settings dialog box. 
 

 
 

 
 

The procedures for setting the date and time are as follows: 
 

1. Enter the date and time according to the following format.  
Date: year (up to 4 digits), month (up to 2 digits), day (up to 2 

digits) 
Time: hour (24-hour clock, up to 2 digits), minutes (up to 2 digits), 

seconds (up to 2 digits) 
Example: To set the date and time of 1/1/2000 1:01:01 PM 

Enter “2000.1.1” for the date, and “13.1.1” for the time. 
(Specify the hours using the 24-hour method even for the 
AM/PM display format.) 

Click the [Keyboard] button to use a virtual keyboard to enter this 
information. A virtual keyboard for entering decimal places is 
displayed.  

  

2. Press the [OK] button after setting the necessary items. 
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MEMO 
♦ When entering months, days, hours, minutes, or seconds that require only 1 

digit, you may enter either 0 + the value or simply the single value by itself. 
Example: The “13.1.1” from above may also be entered as “13.01.01”. 

MMEEMMOO  
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1-5 Error Messages 
This section describes the causes and solutions of each error message 
displayed in Run. Refer to this section for troubleshooting. 
Error messages are displayed in a dialog log similar to the one below. 
 

  
 
 
 
Error messages when Run is started 

Message Cause Solution 
 Reduce the CB size under 
[Settings] – [Run parameter 
setting]  in Builder. 

 Use the argument for either 
INTACORE.INI or 
INTACORE.EXE to increase 
the CB size in shared 
memory.  

CB size is out of range. The number of points used for 
CB set in [Run parameter 
setting] is larger than the CB 
size of the shared memory 
server.  

CW size is out of range. The number of points used for 
CW set in [Run parameter 
setting] is larger than the CW 
size of the shared memory 
server.  

 Reduce the CW size under 
[Settings] – [Run parameter 
setting] in Builder. 

 Use the argument for either 
INTACORE.INI or 
INTACORE.EXE to increase 
the CW size in shared 
memory.  

Run already executing. You have attempted to run 2 
instances of Run.  

Two or more instances of Run 
cannot be run simultaneously.  

Window creation error. A screen could not be created 
due to memory failure, etc.  

Close all other applications 
currently running, and then 
restart the system.  

Cannot create a mutex 
object. 

A screen could not be created 
due to memory failure, etc.  

Close all other applications 
currently running, and then 
restart the system.  
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Error messages when a screen is open 
Message Cause Solution 

Too many local device. 
The maximum size is 
2000 points. 

The number of addresses 
exceeds 2000.  

Use Builder to modify the 
screen data and reduce the 
number of communication 
points to 2000 or less.  

Too many popup 
windows 

You have attempted to open 4 
or more pop-up screens.  

A maximum of 3 pop-up screens 
can be opened simultaneously.  

Cannot open a popup 
window without a base 
window. 

You have attempted to open a 
pop-up screen without 
opening a base screen.  

Page file load error. You have attempted to open a 
screen that does not exist.  

Specify a screen that exists.  

Open a pop-up screen after first 
opening a base screen.  

 
Error messages when operating screens 

Message Cause Solution 
Cannot create the 
virtual keyboard dialog 

The file required for 
displaying the virtual 
keyboard either does not exist 
or has been corrupted.  

Reinstall MotionScreen.  

This RK.DLL is not the 
virtual keyboard 
library. 

The file required for 
displaying the virtual 
keyboard either does not exist 
or has been corrupted.  

Reinstall MotionScreen.  

Cannot load the virtual 
keyboard library 
RK.DLL. 

The file required for 
displaying the virtual 
keyboard either does not exist 
or has been corrupted.  

Reinstall MotionScreen.  

This RTK.DLL is not 
the virtual keyboard 
library. 

The file required for 
displaying the numeral 
keypad either does not exist or 
has been corrupted.  

Reinstall MotionScreen.  

Cannot load the virtual 
keyboard library 
RTK.DLL. 

The file required for 
displaying the numeral 
keypad either does not exist or 
has been corrupted.  

Reinstall MotionScreen.  
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Message Cause Solution 

Cannot add any more. You have attempted to add 
records to the Data Block 
Table that exceed the 
maximum number of records. 

Additions cannot be made in 
excess of the maximum number 
of records. If an addition is 
required, increase the 
maximum number of records in 
[Settings] – [Data Block] in 
Builder.  

Incorrect time format. An incorrect format was used 
when changing the time with 
a time object. Or, an 
impossible time was entered. 
(Example: 25 hours) 

Enter the correct format and 
time. 

Cannot create the 
virtual keyboard dialog. 

The file required for 
displaying the numeral 
keypad either does not exist or 
has been corrupted.  

Reinstall MotionScreen.  

Out of lower range. The value input for Numeral 
Display&Input exceeds the 
lower limit.  

Enter a value that does not 
exceed the lower limit.  

Out of upper range. The value input for Numeral 
Display&Input exceeds the 
upper limit.  

Enter a value that does not 
exceed the upper limit.  

Password error. An incorrect password has 
been entered.  

Enter the correct password. 

Incorrect date format. An incorrect format was used 
when changing the date with 
a date object. Or, an 
impossible date was entered. 
(Example: 32 day) 

Enter the correct format and 
date. 

Password error more 
than 3 times. Password 
input canceled. 

Incorrect passwords were 
entered 3 times in a row.  

Open the PASSWORD dialog 
box again, and enter the correct 
password.  
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Message Cause Solution 

Incorrect file. The file structure of the alarm 
history file (alarm.log) or 
event history file (event.log) 
accessed from Alarm/Event 
Summary&History is not 
correct. 

Delete the alarm history file 
and/or event history file.  

Out of memory. A screen could not be created 
due to memory failure, etc.  

Close all other applications 
currently running, and then 
restart the system.  

 
Error message when operating user objects 

Message Cause Solution 
Cannot use the user 
DLL. 

The number of objects in the 
user DLL exceeds 100.  
An incorrect user DLL has 
been set.  

Create a correct user DLL.  

User DLL is not found. The specified object does not 
exist in the user DLL. 

Create a correct user DLL.  

User object is not found. The user DLL does not exist. Create a correct user DLL.  
Too many user DLLs 
exist. The maximum 
size is 10. 

The number of user DLLs 
exceeds 10.  

Set the number of user DLLs to 
within 10.  

User DLL error. The number of objects in the 
user DLL exceeds 100.  
An incorrect user DLL has 
been set.  

Create a correct user DLL.  
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Error messages when running macro 
The following message is displayed when a macro program error occurs.  
 

 
 
 
 

[ xxx ] : Error details 

Page(xxx) :

ID number of functional object where error occurred (displayed as –1 for 

project macro, screen macro) 

( xxx ) : Macro program timing  

Page number where error occurred (displayed as –1 for project macro) 

ID(xxx) :

 
The information, causes, and solutions displayed in the error details are 
shown below.  

Error details Cause Solution 
Divided by zero Division by zero was 

attempted.  
Set a value other than zero.  

BCD code error A value that cannot be 
converted has been set for the 
argument for BCD and BIN 
commands.  

Check the value of the 
argument that was set, and set 
a correct value.  

Incorrect argument 
value 

An incorrect value has been 
set for the function argument. 

Check the value of the 
argument that was set, and set 
a correct value.  

Incorrect program An incorrect program has 
been set.  

 Check the contents of the 
macro again, and set a correct 
program. 

 Confirm that the selected 
register is installed in a slot 
and the same as the one used 
for the address. 
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Error messages when communicating 
 

Message Cause Solution 
Cannot load DLL. The DLL for CM does not 

exist, or has been corrupted. 
Reinstall MotionScreen.  
If the DLL was created by a 
user, reinstall the DLL required 
for communication.  

Invalid DLL. The DLL for CM does not 
exist, or has been corrupted. 

Reinstall MotionScreen.  
If the DLL was created by a 
user, reinstall the DLL required 
for communication.  

Communication error. 
Exit? 

A communication error has 
occurred.  

 Check if CM is running.  
 Make sure the screen parts 
are not using register address 
which is not available motion 
board.  

Communication open 
error. Quit? 

The file(s) required for 
communication does not exist, 
or has been corrupted.  

Reinstall MotionScreen.  
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Appendix-1 CM Specifications 
For MotionScreen, CM is included as a standard feature for the MP2500. 
This section describes the specifications of the CM.   
For more information on the CM, refer to the MotionScreen Installation 
Guide and the MotionScreen Shared Memory Server manual. 

 

CM Settings 
Contents and setting method for the setting. ini file, CM.INI, of the 
environmental variable for the CM. 

 

Section name Key name and 
form 

Setting details 

System Cyclic Interval Set the cyclic communication interval of 20 ms to 200 
ms. 

 CMID Shared memory connection ID. 1fixed . 
 Thread Priority Select the task/thread priorities from the following 

four choices. 
HIGHEST: Assign a relative priority that is two 

points higher than the thread that serves 
as the standard. 

ABOVE_NORMAL: Assign a relative priority that is 
one point higher than the thread 
that serves as the standard. 

NORMAL: Assign a relative priority that is the same 
as the thread that serves as the standard. 

LOWEST: Assign a relative priority that is two 
points lower than the thread that serves 
as the standard. 

Target TargetCount Set the number of MP2100 controllers to be used for 
communications to a value from 1 to 16. 

 TargetName[n] 
(n: 1 to 16) 

Set the number of slots to the same value as that 
used for TargetCount. 
Example: If the TargetCount equals two, set the 
number of slots to two as follows. 
   TargetName1=MP2100/2500-1slot 
   TargetName2=MP2100/2500-2slot 
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Section name

 EnableRandam Select whether or not to read from a random register 
for CimScope. 

Key name and 
form 

Setting details 

0: Do not use 
1: Use 

Port Select a port number 1to 16 from communication 
manager setting. 

 TargetAddress Select the leading address for the register set in 
TargetDevice. 

Cpu Select a CPU number 1to 4 from communication 
manager setting. 

NetWork Select a network number 1to 254 from 
communication manager setting. 

Station 

 Count Select the number of points for cyclic 
communications in units of words. 

 

 

 

Select a station number 1to 64 from communication 
manager setting. 

[TargetName]

TargetDevice Select the classification of the MP2500 register that 
is used for cyclic communications. 

Unit Select a unit number 1to 63 from communication 
manager setting. 

 IPAddress Specify a character string less than 15 characters for 
the IP address character string from communication 
manager setting. For example: 192.168.1.1 

[TargetName] CimScopeInterval After gaining access to the value stored as the 
ReadMethodCount, set the Sleep Time to a value 
between 0 ms to 100 ms. 

 ReadMethodCount Select the number of times that a high-speed register 
can be accessed consecutively to a value from 1to 100. 

 TimeOut Set the time-out limit in milliseconds (ms). 
Cyclic Count Set the ranges for cyclic communications. 
CyclicBlock[n]

 
HostDevice Select the type of shared memory for cyclic 

communications: CB or CW. ([n]: 1 to the 
value of the 
Count.) 

HostAddress Select the leading address for the shared memory in 
HostDevice. 

TargetID Select the target ID for the MP2500 register that is 
used for cyclic communications.  The Target ID is 
the value of n which is set as TargetName[n] in the 
Target section. 
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MEMO 
♦ 
MMEEMMOO  

The CM.INI file is automatically made if the project is made with Builder. 

♦ Revision of the CM.INI is limited for the fine adjustment of the system.   
Use the CM.INI that was automatically made. 

♦ Do not change any other environmental variables because they are reserved 
for use with the system. 

♦ Please edit the CM.INI with a text editor such as WordPad or NotePad. 
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An example of CM.INI is shown here. 
 

[System] 
Cycle Interval=200 
CMID=1 
Theread Priority=ABOVE_NOMAL 
[Target] 
TargetCount=2 
TargetName1=MP2100/2500-1slot 
TargetName2=MP2100/2500-2slot 
[MP2100/2500-1slot] 
Port=1 
Cpu=1 
NetWork=0 
Station=0 
Unit=1 
IPAddress=192.168.1.1 
TimeOut=10000 
CimScopeInterval=10 
EnableRandam=10 
ReadMethodCouont=10 
HolderName=MP2100 
PluginName=Yaskawa.dll 
[MP2100/2500-2slot] 
Port=1 
Cpu=2 
NetWork=0 
Station=0 
Unit=1 
IPAddress=192.168.1.1 
TimeOut=10000 
CimScopeInterval=10 
EnableRandam=10 
ReadMethodCouont=10 
HolderName=MP2100 
PluginName=Yaskawa.dll 
[Cyclic] 
Count=2 
[CyclicBlock1] 
HostDevice=CW 
HostAddress=0 
TargetID=1 
TargetDevice=SW 
TargetAddress=0 
Count=10 
[CyclicBlock2] 
HostDevice=CW 
HostAddress=10 
TargetID=2 
TargetDevice=SW 
TargetAddress=0 
Count=10 
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Precautions for the cyclic communication range 
・The ranges for CB and CW can be set to a total of 100. 
・Error occurs if the range of another device duplicates within that of CB 
or CW. 
・The leading number of CB and of the communications device as well as 
the number of consecutive points must be in hexadecimal. If not in 
hexadecimal, an error will occur at startup. 

Writing 0x0300L 0x0020L Synchronous Random Write 
 

For details, refer to the MotionScreen SDK manual. 

・To link two of data and treat them as a single value, they must be set 
within the same range. Separate ranges will cause a shift in the writing 
time and may result in a loss of conformity. 
Example: 
Set CW10 and CW11 to the same setting range if CW10 and CW11 are 
used as 32-bit registers. 

 

MEMO 
♦ 
MMEEMMOO  

Set the range for cyclic communications in Device Layout on the Setting 
menu in Builder. For details, refer to "7-6 cyclic communications range 
setting" in Builder manual. 

 

Message communications: Commands and Functions 
Data can be directly exchanged between the application that was made 
with VLAPI and CM. This direct exchange of information is called 
message communications. The following services is available for CM. 
 

Type Cmmnd. 
No. 

Func. No. Request details 

0x0100L 0x0000L Registered 
Monitor 

Clear all. 
 0x0010L Add registration 0 
 0x0011L Add registration 1 
 0x0020L Start monitor 
 0x0030L Monitor interruption 
 0x0040L Monitor request 
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Action when an error occurs 
If a communications error occurs with CM, the error information is stored 
in the following shared memory. 
 

$SB64 CM execution status (0: Normal, 1: Abnormal) 
$SW64 

Shared memory Remarks 

Communication error code 

 

Communication error code 
The following error codes are stored in $SW64. 
 

Error code Cause and remedy 
2 Other task is using shared-memory server. 

Lower the access frequency for the shared memory of the task in the 
shared-memory server, or retry gaining access to the memory. 

6 The selected range for access to the shared memory is out of the 
range for the shared memory. 
Select a value within the allowable range of the shared memory. 

7 Exceeded the maximum number of connections for the 
shared-memory server. 
Increase the maximum number of connections for the 
shared-memory server or reduce the number of applications or CM 
being used. 

8 Buffer size that was set when the shared-memory server was 
connected is too large. 
Make sure that the buffer size has been set correctly or reduce the 
buffer size. 

9 Specified application not found. 
Change settings so shared memory can be accessed for selected 
application. 

10 Address for the selected CM ID No. is not connected. 
Select the CM ID No. for a connected address. 

11 Tried to open a task that is already open. 
That name is already in use. Select another name. 

12 Did not receive data within the allowable time. A time-out error 
occurred. 
Increase the time-out period. 

50 Without connecting to the shared-memory server, use an Open 
function, such as VLA_Open() or VLC_Open(), to call another 
function such as VLA_Read()/ or VLC_Comm(). 
Call VLA_Open() or VLC_Open() first. 
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Error code Cause and remedy 

401 Event cue is incorrect. 
Check handle for the event cue. 

51 Shared-memory server does not start. 
Start shared-memory server. 

100 Insufficient memory in program. 
Reduce program size or remove unnecessary drivers to increase the 
amount of available memory. 

101 Cannot send Request to shared-memory server. 
Lower the access frequency for the shared memory or reduce the 
number of tasks that use the shared memory. 

102 Cannot receive Request to the shared-memory server. 
Lower the access frequency for the shared memory or reduce the 
number of tasks that use the shared memory. 

103 Cannot find connection handle to shared-memory server. 
Check connection handle. 

300 Cannot find the comment file in the selected project. 
Make a new comment file or select another project. 

301 Attempts to gain access to the comment file may fail. 
Check comment file. 

303 Capacity of the file is short or the writing is prohibited. 
Check the disk in which data is being written. 

304 Ｗhen making a comment file with the Create Comment function, 
VLA_CreateCmnt(), a comment file already exists for the selected 
project. 
Select a different project name or select CMNT_CREATE_IFEXIST 
in the ulFlags. 

302 Without the functions VLA_CreateCmnt（） and VLA_OpenCmnt（）, 
call these functions: VLA_GetCmnt（） and VLA_PutCmnt. 
Call VLA_CreateCmnt() and VLA_OpenCmnt() first. 

305 Ｗhen making a comment file with the Create Comment function, 
VLA_CreateCmnt(), the points of CB and CW are out of the 
allowable range or the points are not written in hexadecimal. 
The number and range of CB, CW, $SB, and $SW that were selected 
with the Get Comment and Put Comment functions, 
VLA_GetCmnt() and VLA_PutCmnt()are out of the allowable range. 
Correct the range. 

450 Event not found in event cue. 
Check event cue. 

451 EVQUEUE_PACK ulSize is too small. 
Data size of event being read is too small. 
Check event cue. 
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Error code Cause and remedy 
452 EVQUEUE_PACK pData is not selected.  

Data not found when reading the event. 
Check event cue. 

453 Selected an event cue that has already opened. 
Check handle for the event cue. 

1000 Selected CM ID No. has already used. 
Select another ID No. 

1001 Selected CM ID No. is not within allowable range. Should be 
between 1 through 17. 
When the Open function, VLC_Open () was called, the leading 
number and the points of CB and CW were not correct. 
When the Open function, VLC_Open () was called, of the ranges of 
CB and CW overlap. 
Select a CM ID No within the allowable range. 
Set the leading number of CB to a multiple of 16. So that it is in 
hexadecimal. 
When starting the shared-memory server, set the selected points CB 
and CW to values within the allowable range. 
Correct the range of CB or CW so it does not overlap with that of 
other command modules. 

25346 The port has not been opened. 
Open a port. 

25347 Tried to open a port which is already opened. 
25348 Failed to get the current value needed to make the setting for the 

device. 
25354 Tried to set the device information to an incorrect value. 

Correct the setting. 
25364 Transmitted model was not supported. 

Transmit a model that is supported. 
25365 Error occurs when trying to write more than one register at the 

same time or the number of registers is set to a negative value 
although the buffer is not arranged. 
Correct the setting for the number of registers. 

25374 Register name is incorrect. 
Correct name of register. 

25444 Although opening has been completed, a handle is not set yet or 
another problem exists. 

25454 Selected access mode is not supported. 
25564 Error occurred during communications for system service. 
25574 Error occurred during background service. 

 

 



 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Product Application 

 This product is neither designed nor manufactured for the purpose of being 
used in devices or systems in life-threatening situations. 

 Ask our customer service any questions regarding special usage of this 
product in devices or systems, including but not limited to the following fields: 
vehicle, medical equipment, aerospace related, nuclear related, electric power 
generation and relays stations of a sub-marine cable. 

 Although this product was manufactured under strict quality standards, 
safety devices must be installed when it is used in conjunction with other 
equipment and when a malfunction could lead to a severe accident and 
serious damage. 
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